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2. About this document

2.1. Legend

The following symbols and formats will be used throughout the document.

Important
It gives you important information about the subject.
Please read carefully!

_:OE Hint

It gives you a hint or provides additional information about a subject.

%}\ Example

O Gives you an example of a specific subject.
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3. Key features

The DS-CAM-88c/DS-CAM-120¢/DS-CAM-175¢/DS-CAM-320c are a high-speed Gigabit-Ethernet cameras
with following key data:

DS-CAM-88c: 88 fps @ VGA (640x480)
DS-CAM-120c: 120 fps @ VGA (640x480)
DS-CAM-175c: 178 fps @ VGA (640x480)
DS-CAM-320c: 328 fps @ VGA (640x480)
Color

Auto-gain

Auto-shutter (also fixed shutter possible)
Auto-white balance

Triggered and free-run mode

Standard C-Mount

Small compact form factor

Low power consumption

Ruggedized (high-shock and vibration resistant, aluminium housing)
Real-time data streaming with full resolution

The camera supports the high-performance industrial standard “GigE Vision". The standard introduced
in 2006 provides a framework for transmitting high-speed video and related control over Ethernet
networks.

The benefits are: high speed data transfer rates up to 1GBit/s (based on 1000Base-T) connectible to every
standard GigE Ethernet port and cable lengths up to 100m.

DewesoftX® uses OptoStream SDK for communication with cameras that support GigE Vision standard.

Important
For best performance we recommmended using a SSD for storing data. A disk write rate of 100
MByte/s should be established, especially if using more than 1 camera.

3.1. System Requirements

e 1Gigabit-Ethernet port
High-performance PC (Core i5 CPU or better recommmended, 4 GB RAM and high performance
SSD storage disc)
DewesoftX®
The latest OptoStream SDK
Dewesoft GigE driver (cdv)
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4. Technical data

4.1. Specifications

Color v v v v
Monochrome - - - -
Image sensor Sony ICX414 Sony ICX618 Sony IMX273 Sony IMX287

Sensor type CCD CCD CMOS CMOS
Resolution VGA 640x480 VGA 640x480 1456x1088 728x544

68 FPS @ 1456x1088
116 FPS @ 1280x720 266 FPS @ 728x544
145 FPS @ 800x600 328 FPS @ 640x480
178 FPS @ 640x480

88 FPS @ 640x480
FPS 167 FPS @ 320x240 120 FPS @ 640x480
289 FPS @ 160x120

. 1/2" (12.7 mm 1/4" (6.35 mm 1/2.9" (6.3 mm 1/2.9" (6.3 mm
Sensor size . . . .
diagonal) diagonal) diagonal) diagonal)
Pixel size (in pm) 99x99 56x5.6 3.45 x 3.45 69 x6.9

. 35 dB auto-gain 32 dB auto-gain 71.6 dB auto-gain 74.4 dB auto-gain
Dynamic range

function function function function
Shutter Full frame Full frame Electronic Global Electronic Global
Shutter Shutter
. autoshutter 26ns-60s 58 ns-60s
Shutter time . autoshutter (autoshutter .
function . . (autoshutter function)
function function)
Auto-white v v Y Y
balance
Operating
+5... +45°C +5... +45°C +5... +45°C +5... +45°C
temperature
Operating 25% - 80% 25% - 80% 20% - 80% 20% - 80%
humidity (non-condensing) (non-condensing) (non-condensing) (non-condensing)
44 (H) x 29 (W) x 44 (H) x 29 (W) x 44 (H) x29 (W) x 44 (H) x29 (W) x 86.4
. . 86.4 (D) mm 86.4 (D) mm 86.4 (D) mm (D) mm
Dimensions
173 (H) x114 (W) x 173 (H) x114 (W) x 173 (H) x 114 (W) x 1.73 (H) x 1.14 (W) X
340 (D) in 340 (D) in 340 (D) in 340 (D) in
Lens mount C-mount C-mount C-mount C-mount
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Screw mount Gige  Screw mount GigE Screw r;ch:;nt Cigk Screw gﬁ;ﬂt Cigk
Connectors RJ45 RJ45 Hirosé Hirosée
EIAJ (Hirose) 12 pin  EIAJ (Hirose) 12 pin HRIO-TOR-12PA(73) HRIO-10R-12PA(73)
CE CE CE CE
FCC FCC FCC FCC
Conformit RoHS RoHS RoHS RoHS
Y GigE Vision GigE Vision GigE Vision GigE Vision
GenlCam (PoE IEEE GenlCam (PoE GenlCam (PoE IEEE  GenlCam (PoE IEEE
802.3at) I[EEE 802.3at) 802.3at) 802.3at)
Supply voltage +8 to +30 VDC +8 to +30 VDC +8 to +30 VDC +8 to +30 VDC
Power-over- option option option option
Ethernet P P P P
Power. 36W 36W 32W 32W
consumption
£2.4
M3x3 (7x)
o ol
w i) o
o i ke d (1]
o
T HR & &
G‘J' I— T T h
a4 50 13.4 105 | 12
© - =T
w nis
2 H K U
T T ~ @
N,
\_ C-Mount 71 9.1 22 20
M3x3 (4x) |
—.
80.1
86.4

Illustration 1: Technical drawing with basic dimensions
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Illustration 2: Technical drawing of aluminum adapter plate

DS-CAM-88c / DS-CAM-120c / DS-CAM-175¢ / DS-CAM-320c V22-1 8/40



DS-CAM-88c / DS-CAM-120c / DS-CAM-175¢c / DS-CAM-320c¢ ®
TECHNICAL REFERENCE MANUAL A DEWESOft

Illustration 3: Aluminum adapter mounter on the camera.

4.2. Scope of supply

4.2.1. DS-CAM camera versions

DS-CAM-88c Color camera
DS-CAM-120c Color camera
DS-CAM-175¢ Color camera
DS-CAM-320c Color camera

4.2.2. Accessories

LENS-AZURE-1614mm Azure 1614mm C-MOUNT lens
CABLE-UTP-CAT.6-3m RJ45 CAT 6 cable for data
ALU_PLATE_ADAPTER Aluminum plate adapter with 3x 1/4-20 UNC thread

Power and sync cable, 12-pin Hirose connector to 7-pin Lemo
connector. For CAM-BOX usage only.

CASE_XTRABAG-300 Carrying bag

CABLE-H12f-L1IB7m-3m
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ly Allied Vision

Illustration 2: Scope of supply for DS-CAM

4.2.3. Optional

Power and sync cable, 12-pin Hirose connector splitted to
H12f-L1B2m-LO0OB4mM-3m 2-pin Lemo connector and 4-pin Lemo connector. For SIRIUS

usage.
Power and sync cable, 12-pin Hirose connector splitted to
H12f-L1IB7m-LOOB4m-3m 7-pin Lemo connector and 4-pin Lemo connector. For
DEWE-43 usage only (max 1 per unit).
DS-CAM-IP67 IP67 upgrade kit
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Illustration 3: H12f-L1B2m-LO0B4m-3m and HI12f-L1IB7m-L00B4m-3m are the equal except the pinout is different from one another.
Refer to the tables below

| e weme | oecipon ]

1 +12V Power (+9..+36 V DC)

1 GND Ground

Illustration 16: Pinout of marked connector for
HI12f-L1B2m-L00B4m-3m cable.
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6 +12V Power (+9..+36 V DC)

7 GND Ground

Illustration 15: Pinout of marked connector for
HI12f-L1B7m-LO0B4m-3m

4.3. Connections

On the rear side of the camera there are two connectors. The 12pin HIROSE connector (matching part:
Hirose HR10ATOP-125(73)) contains the power, trigger and other digital pins. Ethernet connector pinout
according to the standard.

Ds-CAM

PC .
GigE NIC Ethemet cable

DC POWER

Power connector
TRIGGER INPUT (2x)

DIGITAL QUTPUT (2x)

Illustration 2: Connecting scheme
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4.3.1. Power/Trigger connector pinout

Illustration 3: 12pin Hirose connector (matching part: Hirose HR1I0A-10P-125(73)) on camera rear side

1 GND (for Power and RS232)

2 Power (+8..+30 V DC)

3 -

4 Camera In 1 (TRIGGER)

5 -

6 Camera Out 1 (open emiter, max. 20 mA)
7 Camera In GND

8 RxD (RS232)

9 XD (RS232)
10 Camera Out Power (for digital outputs)
n Cameraln2

12 Camera Out 2

DS-CAM-88c / DS-CAM-120c / DS-CAM-175¢ / DS-CAM-320c V22-1
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4.3.2. SIRIUS® connection example

In this picture you see a typical SIRIUS measurement instrument, consisting of one SBOX unit
(integrated PC) on bottom and one SIRIUS slice on top (from rear side).

The camera is directly connected to the Gigabit-LAN port. The second cable to the camera contains the
power (from SBOX Power out) and the trigger, connected to the SYNC port of the SIRIUS slice. The
camera frames are now in perfect sync with the analog data acquired by DewesoftX®.

e Hint

-\ /~ Even ifthe camera is connected, synching to other SIRIUS devices is still possible, because there

- are different pins used on the SYNC port for triggering/synching.

lllustration 4: SIRIUS SBOX with 1 SIRIUS slice connected to the DS-CAM-120c (per cable H12f-L1B2m-LO0B4m-3M)
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4.2.4. Connecting multiple cameras

Illustration 7: CAM-BOX2

If you need to connect more than one camera, there is a special “CAM-BOX2" available, which consists of

wide-range voltage input (9-36V)

an industrial Gigabit-Ethernet-Switch (without Power-over-Ethernet! No supply for DS-CAM-600!)
Power and Sync distribution for up to 4 cameras.

Small dimensions: 115 x 62 mm (front) and 135 mm deep
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Camerabox connector

1 -
2 -
k4 -
4 CLK
5 -
6 +12V
lllustration 8: CAM-BOX2 pinout 7 GND

Mating cable connector: FGG.1B.307CLAD52

Power supply connector

2 1 +9V..36V

2 GND

Illustration 8: Power supply

Mating cable connector: FGGJ.1B.302CLLD42Z
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Sync connector

2 -
3 CLK
4 GND

Illustration 8: Sync connector

Mating cable connector: FGG.00.304CLAD27Z

4.2.5. Connections Overview

e.g. SIRIUS

H12f-L1B2m-LO0B4m-3m

\ Ethernet

Illustration 9: DS-CAM to SIRIUS connection example.
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DEWE-43A

H12f-L1B7m-L00B4m-3M

Sync
\ Ethernet

Illustration 10: DS-CAM to DEWE43 connection example.

Important
Maximum of one camera is permissible to connect due to power limitation of DEWE-43A.

Ethernet e.g. S-BOX

H12f- 1
L1B7m-3M Sync

LOOB4m-LOOB4m-3M

Power

L1B2m-L1B2f-3M

CAM-BOX1

Illustration 11: DS-CAM, CAM-BOXI1 for power supply and synchronization. Expanding up to four cameras. Ethernet data cable is
wired directly to the network card of the PC.

Important

If you use more than one camera use an external power supply (PS-200-1L2B3f)
for CAM-BOXI.
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Ethernet

H12f-
L1B7m-
3M

Sync
LOOB4m-LOOB4m-3M

e.g. SIRIUS

CAM-BOX2

Power
L1B2m-L1B2f-3M

Ethernet

Illustration 12: 4x DS-CAM, CAM-BOX2 for power supply and synchronization.

Important
If you use more than one camera use an external power supply (PS-200-L2B3f)
for CAM-BOX2.

4.3. Benchmarks

The following tests were done with SIRIUS SBOX and 1to 4 cameras connected to the CAM-BOX2. Setup:

e 1to 4 cameras connected over CAM-BOX2

e SBOX:128GB SSD -> max 190 MByte/s write rate

e CPU: Intel Corei7 QM57; 2.0CHz; 4GB RAM

e camera(s) clocked by SIRIUS

e Dewesoft X1 SP7 b358 GigEVisionSDK Version 2.7.0.1

e GigE Camera driver v3.5 (Plugin)

e storing data to file, video buffer stable around 0.1%

e with checked "optimize for switched network"

Achieved framerates (fps)
1camera

640 480 88 120
320 240 165 195
320 120 280 300
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2 cameras

640 480 88 120

320 240 165 195

320 120 280 210
3 cameras

640 480 88 20

320 240 165 195

320 120 280 210
4 cameras

640 480 88 60

320 240 165 195

320 120 280 210
YL Hint

~ 4
:O: Results (FPS) should be considered only as approximate MAX values. Writing speed of the disk
= may be a limiting factor (we used SSD!). We recommend to test cameras with your setup at
about 0.8*max_FPS and higher to find where corrupted image, frame lost or buffer overrun will
occur.

5. Installation

5.1. DewesoftX® full installer

For DewesoftX® all the drivers come with the full installer, if you select the option “GigE camera driver”
during installation. To check if the drivers are installed, go to Options » Installed extensions and see if the
checkbox “GigE” is visible. If not, execute the full installer again, choose the Modify option and enable the
checkbox of GigkE camera.
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Dewesofti o

Welcome

Modify, repair, or remove the program.

ct which options to install for Dewesofty 2020.2.

0¥ Modify

ct new program features to add or select currently installed features to

Reinstall all program features installed by the previous setup.

ol

if# Remove

Remove all installed features.

< Back Mext = Cancel

Illustration 6: Installation

The last DewesoftX® full installer can be downloaded here:
https://download.dewesoft.com/list/dewesoftx
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Dewesofti

Select Features

Select the features setup will install.

lect which options to install for Dewesofty

Dewesoft
-[#|Dewesoft Launcher
=-[]Extensions
=[] cameras
[ L ATelemetry camera

GigE camera

["|Exports

-- Visual controls
+-[~]Drivers

+-[#]|External dependendies
+- [ Manuals

DEWESoft

< Back Mext =

Jescription

Cancel

Illustration 7: Installing GigE camera driver

5.2. Manual installation

5.2.1. Required files

OptoStream SDK for GigE Vision

e Go to https://download.dewesoft.com/list/plugins/ and download GigE package
e Itincludes the latest OptoStream SDK and Dewesoft driver for GigE Vision.

DewesoftX®

e Available from https:/download.dewesoft.com/list/dewesoftx

DS-CAM-88c / DS-CAM-120c / DS-CAM-175¢ / DS-CAM-320c V22-1
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., Hint

s i

~ 4

:< ): You need to be logged into the Dewesoft website to download the latest development versions
T  of DewesoftX®.

5.2.1. Step-by-step instruction

Ist step: Install OptoMotive_OptoStreamSDK

Note that you must be an administrator, not just a user with admin rights! Restart the PC after
installation is complete. After reboot be sure that “OptoStream GEM Filter Driver” is installed (picture 1)
under Local area Connection Properties.

e, Hint

,O. Note that “Filter Driver” filters out all packets that are not GigE on hardware level, so the camera
<  will work much faster than without the filter.

U Ethernet Properties et

Metworking  Sharing

Connect using:

I? Irtel(R) Ethemet Connection (6) [215-V

This connection uses the following tems:

£3 Client for Microsoft Networks ~
’:]? File: and Printer Sharing for Microsoft Netwarks

I3 EthercatDAQ Fiter

o aOptoStream GEV Filter Driver
T eBUS Universal Pro For Ethemet Driver
005 Packet Scheduler

4 Intemet Protocol Version 4 (TCP/IPw4) W
£ >

Imstall... Uningtall Properties
Description

MDI56 GigE Vision Fitter Driver

QK Cancel

Illustration 8: Installed OptoStream GEV Filter Driver.
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2nd step: Connect camera to PC via Ethernet cable and power/trigger cable. See chapter 4.2.5.
Connections Overview

3rd step: Assigning IP address to camera

The DS-CAMs supports DHCP, so just set your computer's |IP address to automatic and wait until the IP is
assigned. To test if the camera is working you can run OptoStreamViewer. By right-clicking on the
camera model you can also set IP to fix, if you prefer.

(¥ OptoStreamViewer - Manta_G-031C (E0020015) - 00:0F:31:4E:09D:E3 - 192.168.1.123

File View Control Displays Help
BB PE «aalF
Devices [=]ES]

Model ¥ MAC or SN Address
© Manta_.. 00:0F:31:4E:0D:E2 IP: 192.168.1.123

Device Properties =]ES]

u Start 6 Stop

Parameters Device Info Registers

Illustration 9: OK, cameras can be used, close the OptoStreamViewer and start DewesoftX®.

Important
You should avoid using OptoStreamViewer and DewesoftX® in parallel.

4th step
To enable the camera in DewesoftX® copy the file “GigeECamera.cdv” into the Dewesoft Addons folder,

usually located in “C\DewesoftX\Bin64\Addons64\GigeCam".

5th step
Run the "Dewesoft DCOM Registration” to register the plugin.
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| = | Bing4

« o v

Share View

() Mame

» 3 Quick access

> o OneDrive

v [ This PC
> _J 3D Objects
> [ Desktop

»  [E Documents W e

» ThisPC » Local Disk (C:) » Dewesoft{ » Bind »

.

% canarncmibd.dil

candhcbd.dll

| Cgostd.dil

d3dxd_33_6d.dll
£s DEWEsoft.exe
[ ] DEWESoft.map

wr

@ Dewesoft DCOM and addons registration (ver, 1.7) 4

Addans

[] pewesoft DCOM server

3DModel&4. ve OK ~
ADMA,_Ethernet.dll OK
ARIMC_MIL155384.dll OK
ASAM_MDF464. exp OK
ASAM_ODS64.exp OK
AttitudeIndicatorg4.vc OK
AutoExporta4.dil Ok
BarcodeScannera4.dll OK
BrakeMoise64.dll OK
BrakeTesto4.mth OK
BWF.exp OK

Thanter 10A4 All Ok

Illustration 10: OK, cameras can be used, close the OptoStreamViewer and start DewesoftX®

6th step

Start DewesoftX® and go to Options » Settings » Analog. For triggered mode (DewesoftX® is clocking
the camera), check if your device (such as DEWE-43 for example) is set to Automatic or Clock/Trigger:

Operation mode

®

~ &} Local system
w - M Dewesoft Devices
¢ bt SIRIUSICD
- e DEWE-43-A
v El GigE
‘... Allied Vision Technologies - M

o

|REaI measurement ™ |
= Synchronization
Time source | Dewesoft DAQ Devices - |
Dewesoft DAQ Devices @
Clock provider | IRIG-B DC

Clock/Trigger

@ Settings IRIG-B DC
Channel setup sample rate |2[JUUU | sfsfch
Enable DSI adapters, TEDS sensors @

Illustration 11: Options --> Settings: Set device to Automatic (Standalone) or Clock/Trigger
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7th step

Go to the GigE tab and set “Use trigger”.

Settings for project: default

Operation mode ’W
@ Extensions @ @ 0 Found 1 camera(s)
Mo, ‘ MName | Enabled | Camera status: device is connected
IE] clobal variables v e__:aé::?::& Devices 0 Alied Vision Technologies - Manta_G-031C (E0020015) Yes Hua IP address:
-~ SIRIUSI-CD DHCP Subnet mask:
% Data header v :;;EDEWE434'-\ | P ——
o Startup - @ Allied vision Technologies - M BAPermanent T - Gateway:
N,i performance 2 TITEE
{D User interface
= Files and folders
B storing
@ Reports
a Security
@ Update v < > E Use triggerl
N

llustration 12: DewesoftX® hardware setup, add GigE.

“File format” should be set to

e “DVI", which is uncompressed DewesoftX® video format (takes a lot of disk space, ~35 Mbyte /s /
camera @ 640x480 and 120fps, but no video size limit) — or

e “AVI" the live compression will take CPU power, performance depends on the used computer;
but we have experienced good results with the Xvid codec (uses multiple cores); consider that
AVI will stop recording after video file size reaches 2 GB.

e ‘“compress after measurement”: if you have a triggered measurement, you can use the pause

times to automatically compress a recorded video file after storing

For manual compression after the measurement set the appropriate compressor in “AVI file type for

compression”. We recommend the XVID codec. In Analysis mode you can then manually select your
datafile and click “AVI compress”.

‘\ [ Q DewesoftX = 0 b
e Measure Analyze Datz fles  Setup  Review = Options
~7 ’ e— H
G @ O o | @ | = @ w 0 0O (m
Import  Multifle export Apply action Use for measure Revert to orig) AVI compress |Post-sync. video Load Rename Delete Copy Cut Paste

Data

Q

~ I - ISearch
+

File name
'y

Version

< Example drive.dxd 2,1MB %3 5P11(RELEASE-200418) (64-bit)  ©

750kE  2020.1 (RELEASE-200! (B4-bit)

Illustration 13: AVI compress after measurement
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8th step
Go to Ch. Setup, click the Video tab, click the Unused button to enable the video channel.
+ + I
O B H @ W = % +
Store Save Save as Storing Analog in Video Math More...  Remove
Camera options
Store options Frame rate
|always fast w | |1[J£J v |
ID | C Used Channel name ‘ Camera name ‘ Camera status | Setup
1] Camera 0 | Allied vision Technologies - Manta_G-031C (E0020015) | Frame rate: 100.00 fps Setup
Illustration 14: DewesoftX® Channel setup » add Video
i, Hint

~ 4
',< >: Ensure the firmware version of Dewesoft hardware is up to date, otherwise follow the
= instructions of how to do it in the Updating firmware article.

9th step

Enter the channel setup. By now, already a picture should be shown.
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Carnera 0 (Allied Vision Technologies - Manta_G-031C (E0020015))

Resolution

Colar 640 x 480 ~

Frame rate
100,00 frames/s (Max: 127.80)

Preview - 100.0 fps/ 29.3 MB/s

Shutter
[ | 3359.95
Gain
[ ] 11,41
Automatic shutter Off v
Automatic gain off v
Automatic white balance | Off ~

[[] optimize for switched network Facket size: 2000 kb

Advanced setup...

Illustration 15: DewesoftX® video channel setup

1.  Hint
',O: If you change the frame rate, after typing the value, the input field gets a yellow color; confirm the
= value by pressing the Enter key

Use the “Advanced Settings”, if you want to change specific parameters of the camera, such as the
custom resolution (AQI, area of interest) for instance.
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-Info
-GigE
-StreamHold
- Timestamp

Acquisition

- Trigger
-ImageMode
-ImageFormat

Controls

- D5PSubregion

-Exposure

- ExposureAutoControl

- GainControl

- GainAutoControl
-BlackLevelContral
-Whitebalance
-BalanceWhiteAutoControl
-Iris

- DefectMask
-SubstrateVoltage

-Color Transformation Control
-LUTControl

-LUTInfo

i(a]

-Syncln

- SyncOut
-Strobe
-EventControl
-EventID
-SavedUserSets

none

Camera controls:

©

Mote: When in a text box, press return key to apply setting.
Some settings can be changed only when camera is not running.

Close

lllustration 18: Advanced settings
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6. Troubleshooting guide

GigE checkbox in hardware setup missing / Support for 64 bit Windows:

Go to My Computer and click System properties > Advanced system settings > Advanced tab >
Environment Variables > System variables > select Path > Edit.

Make the following changes:

e %OPTOSTREAM_SDK_PATH%\bin
o %GENICAM_ROOT_V2_4_ARCH%\bin\Windows
e %GENICAM_ROOT_V2_4_ARCH%\bin\Windows \GenApi\Generic

Save and reset Windows. Path correctness can be checked by GetEnvironmentVariable('PATH');

No picture shown, “No frames received” error
If you receive the error “NO FRAMES RECEIVED”, check: -

Is the Trigger/Sync cable connected?

Try decreasing the Shutter value

Check in Settings if the DewesoftUSB device is set to Clock/Trigger or Automatic (Standalone)
Disable Trigger in hardware setup and check if it's working in free-run mode (This could
potentially be a cable problem. Swap in new cables and try again)

Camera not found (not in OptoStreamViewer, not in DewesoftX®)

Check if the status LED on the camera is green, booting takes ABOUT 1 MINUTE!
If using a GigE-Switch with PoE ports, ensure output power is sufficient, check status LED during
operation

e Check Windows Firewall settings

Cameras not found in DewesoftX® (yellow mark in OptoStreamViewer):

Not able to use the cameras. Please wait a little bit (until IP is assigned). If that does not help, ensure the
computer's network IP is set to automatic, as the camera supports DHCP.

Further troubleshooting, most probably the computer and the camera are not in the same subnet.
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:’l'l‘: OptoStrearnViewer

File View Control Displays Help

W PEH o aa
Devices [ (%
Model ¥ MAC or SN Address

A Manta_.. 00:0F:31:4E:9D:E3 IP: 192.168.1.123

Device Properties ]

Illustration 19: IP address problem

Important
You should avoid using OptoStreamViewer and DewesoftX® in parallel. If the cameras are
found, close DewesoftX® restart OptoStreamViewer.

Change IP address of the camera

o OptoStreamViewer

File View Contrel Displays Help

BB PE QAW D

Devices &

| k]
"

£

Model MAC IP Address
€3 Manta_.. 00:0F:31:4E:9D:E3 IP: 192.168.1.123
“#® Connect Device
¥#® Disconnect Device
5B Setlp To Device
‘_ﬁ_; Find Devices

If you manually change the IP address, please close DewesoftX®, start the OptoStreamViewer, right-click
on the camera and select “Set IP to device”; use the same subnet as the computer, example:

PC:192.168.1.120, Subnet 255.255.255.0
Camera: 192.168.1.123, Subnet 255.255.255.0

The IP is ok, if the cameras are found with a red mark (see lllustration above), close OptoStreamViewer
and start DewesoftX®.
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GigEVision client does not start, error message when starting

Troubleshoot this using the following steps: Check if the operating system of your computer is 32bit or
64bit.

Copy the 64-bit dlls (otherwise take the ones from the 32bit directories) from
C\Program Files\OptoMotive\OptoStreamSDK\bin\Win64 and
C\Program Files\OptoMotive\OptoStreamSDK\GenlCam_v2_4\bin\Win64_x64 to
\Windows\system32 (respectively \Windows\SysWOW64)
Then start the OptoStreamViewer from C\Program Files\OptoMotive\OptoStreamSDK\bin\Win64
Cameras not working in DewesoftX®

If you followed the step-by-step installation procedure, but still the camera is not working in
DewesoftX®, you can try to copy the used dlls manually:

Copy the 32-bit dlls from
C\Program Files\OptoMotive\OptoStreamSDKbin\Win32
and
C\Program Files\OptoMotive\OptoStreamSDK\GenlCam_v2_4\bin\Win32_i86

to Dewesoft's Addons folder. Then restart DewesoftX®.

Maximum frame rate @ VGA resolution only 36 fps

When you adjust the framerate higher than 36 fps, and it is always reset to 36 fps, the Ethernet card in
your computer is most probably only 100 Mbit/s. Please check the control panel » network card
properties. Gigabit-Ethernet (1000 Mbit/s) is required.

Performance improvements (e.g. in case of frames lost, CPU overload or buffer overrun)
A loss of a few frames during a measurement is normal, due to collisions on the Ethernet network.
Here are some useful hints to improve the performance:

e Do not operate the camera in a fully loaded network (e.g. office computers). Just use direct
connection or one switch (with no additional participants).
Disable all anti-virus, firewall, indexing and synchronization programs running in background.
Also check if you really have a Gigabit-Ethernet network card, not only 100Mbit/s.
Check if the LAN cable is at least of CAT5 quality, if you have longer cable lengths it should be
even better.
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For this camera, the main improvement can be done by using a SSD (disk writing speed about

100..150 Mbyte/s. One camera at 640x480 @ 120fps takes about 35MByte/s, multiply the value

with the number of cameras used)

Disable any “live compression” in Hardware setup - Video. Codec may take CPU load.

Try to decrease the framerate / resolution

Use the Windows resource monitor (can be found in Task manager) to check for bottlenecks.

For optimal performance we recommend enabling “Jumbo” frames on your PC network card.

“Jumbo” frames are Ethernet packets larger than 1500 bytes. This way less CPU time is spent for

data reception therefore increasing performmance and minimizing data loss. (Control panel ->

network and internet -> view network status and tasks (network and sharing center) -> change

adapter settings -> right-mouse-click on LAN connection -> Properties -> Configure -> Advanced

->Jumbo Frame -> set to highest value (e.g. 9kB MTU))

e Also an overloaded DewesoftX® setup (many displays, e.g. high resolution FFT instruments) will
take system power. Try at first only with camera video instruments.

e Press <Ctrl>+<Shift>+<P> in DewesoftX® Measure mode. On the right side the performance

monitor will appear. Watch the Cam video buffer. It should stay stable at low values.

CPU1 259

cruz N 259

cru3 0%

cru4 o oo,

CPUS I 159

crue I 10%

cPu7 I 20%

crus I 159
Memory used

Phoysical [ 7%

Fres: 6,586/7,085 MB

o I 5%

Frea: 60,342/51,445 MB

PTIO | 1%

Fres: 400,471/406,438 ME

oAG B 24

Diaq proc, speed: 0 MS/sec

CAN buil 0%

Used: O MB

Cam 1 45%

Video rate: 100 fps

Illustration 20: IP address problem
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7. Warranty information

Notice
The information contained in this document is subject to change without notice.

Note:

Dewesoft d.o.o. shall not be liable for any errors contained in this document. Dewesoft MAKES NO
WARRANTIES OF ANY KIND WITH REGARD TO THIS DOCUMENT, WHETHER EXPRESS OR IMPLIED.
DEWESOFT SPECIFICALLY DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. Dewesoft shall not be liable for any direct, indirect, special, incidental, or
consequential damages, whether based on contract, tort, or any other legal theory, in connection with
the furnishing of this document or the use of the information in this document.

The copy of the specific warranty terms applicable to your Dewesoft product and replacement parts can
be obtained from your local sales and service office. To find a local dealer for your country, please visit

https:/dewesoft.com/support/distributors.

7.1. Calibration

Every instrument needs to be calibrated at regular intervals. The standard norm across nearly every
industry is annual calibration. Before your Dewesoft data acquisition system is delivered, it is calibrated.
Detailed calibration reports for your Dewesoft system can be requested. We retain them for at least one
year, after system delivery.

'7.2. Support

Dewesoft has a team of people ready to assist you if you have any questions or any technical difficulties
regarding the system. For any support please contact your local distributor first or Dewesoft directly.

Dewesoft d.o.o.
Gabrsko 11a
1420 Trbovlje Slovenia

Europe Tel.: +386 356 25 300

Web: http:/www.dewesoft.com
The telephone hotline is available Monday to Friday from 07:00 to 16:00 CET (GMT +1:00)

7.3. Service/repair

The team of Dewesoft also performs any kinds of repairs to your system to assure a safe and proper
operation in the future. For information regarding service and repairs please contact your local

distributor first or Dewesoft directly on https:/dewesoft.com/support/rma-service.
7.4. Restricted Rights

Use Slovenian law for duplication or disclosure. Dewesoft d.o.o. Gabrsko 11a, 1420 Trbovlje, Slovenia /
Europe.
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7.5. Printing History
Version 2.0.0, Revision 217 Released 2015 Last changed: 23. July 2018 at 16:54.

7.6. Copyright

Copyright © 2015-2019 Dewesoft d.o.0. This document contains information which is protected by
copyright. All rights are reserved. Reproduction, adaptation, or translation without prior written
permission is prohibited, except as allowed under the copyright laws. All trademarks and registered
trademarks are acknowledged to be the property of their owners.

7.7. Trademarks

We take pride in our products and we take care that all key products and technologies are registered as
trademarks all over the world. The Dewesoft name is a registered trademark. Product families (KRYPTON,
SIRIUS, DSI, DS-NET) and technologies (DualCoreADC, SuperCounter, GrandView) are registered
trademarks as well. When used as the logo or as part of any graphic material, the registered trademark
sign is used as a part of the logo. When used in text representing the company, product or technology
name, the ® sign is not used. The Dewesoft triangle logo is a registered trademark but the ® sign is not
used in the visual representation of the triangle logo.
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8. Safety instructions

Your safety is our primary concern! Please be safe!

8.1. Safety symbols in the manual

Warning
Calls attention to a procedure, practice, or condition that could cause the body injury or death

Ql/_  Caution
. Calls attention to a procedure, practice, or condition that could possibly cause damage to
equipment or permanent loss of data.

8.2. General Safety Instructions

. Warning

The following general safety precautions must be observed during all phases of operation, service, and
repair of this product. Failure to comply with these precautions or with specific warnings elsewhere in
this manual violates safety standards of design, manufacture, and intended use of the product. Dewesoft
d.o.o0. assumes no liability for the customer’s failure to comply with these requirements.

All accessories shown in this document are available as an option and will not be shipped as standard
parts.

8.2.1. Environmental Considerations

Information about the environmental impact of the product.

8.2.2. Product End-of-Life Handling

Observe the following guidelines when recycling a Dewesoft system:

8.2.3. System and Components Recycling

Production of these components required the extraction and use of natural resources. The substances
contained in the system could be harmful to your health and to the environment if the system is
improperly handled at its end of life! Please recycle this product in an appropriate way to avoid
unnecessary pollution of the environment and to keep natural resources.

This symbol indicates that this system complies with the European Union’s requirements
K according to Directive 2002/96/EC on waste electrical and electronic equipment (WEEE).

Please find further information about recycling on the Dewesoft web site www.dewesoft.com

I Restriction of Hazardous Substances
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This product has been classified as Monitoring and Control equipment and is outside the scope of the
2002/95/EC RoHS Directive. However, we take care of our environment and the product is lead-free.

8.2.4. General safety and hazard warnings for all Dewesoft systems

Safety of the operator and the unit depend on following these rules.

Use this system under the terms of the specifications only to avoid any possible danger.

Read your manual before operating the system.

Observe local laws when using the instrument.

DO NOT touch internal wiring!

DO NOT use higher supply voltage than specified!

Use only original plugs and cables for harnessing.

You may not connect higher voltages than rated to any connectors.

The power cable and connector serve as Power-Breaker. The cable must not exceed 3 meters, the
disconnect function must be possible without tools.

Maintenance must be executed by qualified staff only.

During the use of the system, it might be possible to access other parts of a more comprehensive
system. Please read and follow the safety instructions provided in the manuals of all other
components regarding warning and security advice for using the system.

With this product, only use the power cable delivered or defined for the host country.

DO NOT connect or disconnect sensors, probes or test leads, as these parts are connected to a
voltage supply unit.

Ground the equipment: For Safety Class 1 equipment (equipment having a protective earth
terminal), a non-interruptible safety earth ground must be provided from the mains power
source to the product input wiring terminals.

Please note the characteristics and indicators on the system to avoid fire or electric shocks. Before
connecting the system, please read the corresponding specifications in the product manual
carefully.

The inputs must not, unless otherwise noted (CATx identification), be connected to the main
circuit of category II, lll and IV.

The power cord separates the system from the power supply. Do not block the power cord, since
it has to be accessible for the users.

DO NOT use the system if equipment covers or shields are removed.

If you assume the system is damaged, get it examined by authorized personnel only.

Adverse environmental conditions are Moisture or high humidity Dust, flammable gases, fumes
or dissolver Thunderstorm or thunderstorm conditions (except assembly PNA) Electrostatic fields,
etc.

The measurement category can be adjusted depending on module configuration.

Any other use than described above may damage your system and is attended with dangers like
short-circuiting, fire or electric shocks.

The whole system must not be changed, rebuilt or opened.

DO NOT operate damaged equipment: Whenever it is possible that the safety protection features
built into this product have been impaired, either through physical damage, excessive moisture,
or any other reason, REMOVE POWER and do not use the product until the safe operation can be
verified by service-trained personnel. If necessary, return the product to Dewesoft sales and
service office for service and repair to ensure that safety features are maintained.

If you assume a more riskless use is not provided anymore, the system has to be rendered
inoperative and should be protected against inadvertent operation. It is assumed that a more
riskless operation is not possible anymore if the system is damaged obviously or causes strange
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noises. the system does not work anymore. The system has been exposed to long storage in
adverse environments. the system has been exposed to heavy shipment strain.

e \Warranty void if damages caused by disregarding this manual. For consequential damages, NO
liability will be assumed!

e Warranty void if damage to property or persons caused by improper use or disregarding the
safety instructions.

e Unauthorized changing or rebuilding the system is prohibited due to safety and permission
reasons (CE).

e Be careful with voltages >25 VAC or >35 VDC! These voltages are already high enough in order to
get a perilous electric shock by touching the wiring.

e The product heats during operation. Make sure there is adequate ventilation. Ventilation slots
must not be covered!

e Only fuses of the specified type and nominal current may be used. The use of patched fuses is
prohibited.

Prevent using metal bare wires! Risk of short circuit and fire hazard!

DO NOT use the system before, during or shortly after a thunderstorm (risk of lightning and high
energy over-voltage). An advanced range of application under certain conditions is allowed with
therefore designed products only. For details please refer to the specifications.

e Make sure that your hands, shoes, clothes, the floor, the system or measuring leads, integrated
circuits and so on, are dry.

e DO NOT use the system in rooms with flammable gases, fumes or dust or in adverse
environmental conditions.

e Avoid operation in the immediate vicinity of high magnetic or electromagnetic fields,
transmitting antennas or high-frequency generators, for exact values please refer to enclosed
specifications.

e Use measurement leads or measurement accessories aligned with the specification of the
system only. Fire hazard in case of overload!

e Do not switch on the system after transporting it from a cold into a warm room and vice versa.
The thereby created condensation may damage your system. Acclimatise the system unpowered
to room temperature.

e Do not disassemble the system! There is a high risk of getting a perilous electric shock. Capacitors
still might be charged, even if the system has been removed from the power supply.

e The electrical installations and equipment in industrial facilities must be observed by the security
regulations and insurance institutions.

e The use of the measuring system in schools and other training facilities must be observed by
skilled personnel.

The measuring systems are not designed for use in humans and animals.
Please contact a professional if you have doubts about the method of operation, safety or the
connection of the system.

e Please be careful with the product. Shocks, hits and dropping it from already- lower level may
damage your system.

e Please also consider the detailed technical reference manual as well as the security advice of the
connected systems.

e This product has left the factory in safety-related flawlessness and in proper condition. In order to
maintain this condition and guarantee safety use, the user has to consider the security advice
and warnings in this manual.

EN 61326-3-1:2008
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IEC 61326-1 applies to this part of IEC 61326 but is limited to systems and equipment for industrial
applications intended to perform safety functions as defined in IEC 61508 with SIL 1-3.

The electromagnetic environments encompassed by this product family standard are industrial, both
indoor and outdoor, as described for industrial locations in IEC 61000-6-2 or defined in 3.7 of IEC 61326-1.

Equipment and systems intended for use in other electromagnetic environments, for example, in the
process industry or in environments with potentially explosive atmospheres, are excluded from the
scope of this product family standard, IEC 61326-3-1.

Devices and systems according to IEC 61508 or IEC 61511 which are considered as “operationally
well-tried”, are excluded from the scope of IEC 61326-3-1.

Fire-alarm and safety-alarm systems, intended for the protection of buildings, are excluded from the
scope of IEC 61326-3-1
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9. Documentation Version

Revision number: 101

Last modified: Tue 23 Dec 2014, 16:45

1.0.0 13.08.12 initial revision
1.0 24.09.12 Changed benchmarks because of improvements in Gige Cam driver
1.7
1.0.2 24.09.12 More detailed path in “Support for 64 bit Windows”
1.0.3 04.10.12 Added secton 2.2.4 “Connections Overview”
1.0.4 021112 Cable changed from camera to DEWE-43 in section 2.2.4
1.0.5 271112 Changed first FAQ to “GigE checkbox in hardware setup missing /..."
1.0.6 26.02.13 General update, CAM box pinout, more FAQs, small corrections
1.0.7 02.07.13 Changed name to “DS-CAM-120c”; minor hints and corrections,
dimensions added
1.0.8 16.10.13 Added FAQ “GigE plugin is not found in DEWESoft”
1.0.9 26.11.13 Added FAQ “Maximum frame rate @ VGA resolution only 36 fps”
11.0 221214 Merge of DS-CAM-88c and DS-CAM-120c into one manual added new
benchmarks for DS-CAM-88c
V20-1 05.10.20 New template
V20-2 12.10.20 Added DS-CAM-175¢c and DS-CAM-320c
V22-1 04.03.22 4.3.2. SIRIUS® connection example
- Change power/sync cable to H12f-L1B2m-3m
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